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В учебно-методическом пособии приводятся краткие теоретические сведения, пособие содержит подробную инструкцию по работе в среде ANSYS Workbench, является руководством для приобретения минимального навыка работы с ее графическим интерфейсом (с ее системой меню, окон, команд).

В пособии приведен пошаговый порядок действий при решении статической задачи конструкционного анализа, на конкретных примерах, с иллюстрациями описан весь процесс подготовки задачи к вычислению, получения расчетных результатов, возможностей их наглядного представления, проведения на основе  полученного решения грамотного инженерного анализа конструкции, порядок выполнения и варианты заданий по курсовой работе.
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Введение

К числу лидеров систем инженерных расчетов и анализа CAE следует отнести комплекс ANSYS. Все программы пакета ANSYS имеют простой интуитивный пользовательский интерфейс на основе командного меню. Наличие в нем интегрирующей среды проекта ANSYS Workbench позволяет встроить систему ANSYS в систему Product Development Management (PDM), благодаря чему достигается еще более эффективный и структурированный подход к организации процесса проектирования.

Большое количество пользователей программного обеспечения ANSYS занято в космической и авиационной промышленности, где они занимаются разработкой разнообразных космических летательных аппаратов, спутников, орбитальных станций, самолетов, ракет 
Нефтегазовое оборудование комплектуется стальной запорной трубопроводной арматурой. Наличие неисправностей, перегревов различных участков являются причиной более 80% отказов трубопроводной арматуры, которые приводят к нарушению нормального режима функционирования оборудования или к аварийным ситуациям. 
С помощью ANSYS проводятся исследования трубопроводной арматуры на распределение температур, в зависимости от граничных условий и с указанием условий конвективного теплообмена с рабочей и окружающей средами.

Также активно используется среда ANSYS в автомобилестроении. Возможности продуктов ANSYS позволяют проводить прочностной анализ с учетом воздействия температурных потоков, теплообмена, контактных сопротивлений, упругих и пластических деформаций.

Программный комплекс ANSYS обеспечивает точный и быстрый анализ конструкции, что позволяет произвести правильный расчет, для более надежной работы устройства.

При моделировании устройств, благодаря тому, что программный продукт ANSYS выводит красочные и легкие для понимания карты распределения нагрузок, температур легко видеть, какие участки являются наиболее проблемными.

1. Статический конструкционный анализ в среде ANSYS
1.1 Последовательность решения задачи
1.1.1 Трансляция геометрической модели
Анализ может быть выполнен при наличии геометрической модели исследуемой конструкции. Геометрическая модель может быть создана в любом CAD продукте (например в КОМПАС 3D).

Существует два способа активировать модуль вычислений и импортировать в него геометрическую модель из внешней CAD программы:

1. Запустить Ansys Workbench, затем указать название и местоположение файлов через интерфейс Ansys Workbench
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2. Транслировать геометрическую модель из интерфейса CAD программы и одновременно запустить вычислительный модуль
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1.1.2. Компоненты пользовательского графического интерфейса  Ansys Workbench:
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1.1.3 Часто используемые команды меню:
File>Save - сохранить базу данных в файл .dsdb;

File>Clean - удалить сетку и расчетные результаты из базы данных;

Edit>Select All - выбрать все текущие объекты рабочего окна;

Units - изменить систему единиц измерения;

Tools>Options...- изменить настройки;

Help>Asys Simulation Help - вызвать справочную информацию.
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Существует 4 набора инструментов для быстрого доступа к командам, содержащимся в разделах меню:
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Левая клавиша мыши может работать либо с инструментом выбора объектов, либо с инструментами управления изображением.
Объекты CAD геометрии можно выбрать, указав мышью каждый объект отдельно или ограничив область выбора контуром. 
Переключение осуществляется нажатием пиктограммы "Выбор" [image: image8.png]@
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1.1.4.Дерево проекта
В дереве проекта организованы все этапы расчёта: 
I. геометрическая модель, 
II. материалы, 
III. сетка, 
IV. нагружение,
V. расчётные результаты.

Через дерево проекта осуществляется быстрый доступ к настройкам всех этапов расчёта.

В разделе "Model" содержатся исходные данные для расчёта.

"Geometry"- геометрическая модель.

"Contact" - контактные условия.

"Mesh'- сетка.

"Environment'- нагружение.

"Solutoion" -расчетные результаты.

'Engineering Data" - свойства материалов и граничные условия (например, конвекция)
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1.1.5. Окно настроек

Окно настроек дает доступ к назначению и изменению параметров.

Содержание окна настроек меняется в зависимости от позиции, выбранной в дереве проекта
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	- Белое поле: ПАРАМЕТРЫ.

Данные можно редактировать: следует выбрать поле и изменить значение.

При редактировании данных следует


выбрать геометрические объекты в рабочем окне, затем нажать кнопку "Apply"


либо набрать новое значение на клавиатуре


либо выбрать необходимую позицию в списке.

- Серое (или красное) поле: ИНФОРМАЦИЯ.


Данные нельзя редактировать (это максимальное напряжение, количество узлов сетки и т.п.)

- Желтое поле: НЕЗАДАННЫЕ ПАРАМЕТРЫ.


Параметры не заданы; следует ввести численные значения или сделать выбор, чтобы полностью определить задачу.




В рабочем окне выводится геометрическая модель, а также - расчетные результаты, табличные данные, графики, отчеты HTML.
Переключение функций рабочего окна осуществляется через вкладки.
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1.1.6. Мастер расчетов

Мастер расчетов напоминает пользователю, какие действия следует выполнить, чтобы провести решение:
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После запуска программы и трансляции геометрической модели высвечивается начальная панель, которая позволяет выбрать тип задачи и соответствующий шаблон расчетов.
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Начальную панель можно отключить в меню:
"Tools>Options...> Simulation:Starup"

Начальная панель содержит мастер расчетов и предоставляет возможность выбрать тип решаемой задачи:
При включении программы на начальной панели перечислены типы решаемых задач и список разрешенных лицензий.

Например, при выборе на начальной панели позиции "Static Structural" (расчет напряжений) формируются автоматически шаги мастера расчетов (справа) и позиции дерева проекта (слева), включая список расчетных результатов.
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При выборе каждого шага в мастере расчетов появляется всплывающая подсказка
Например, пр выборе шага "Verify Materials" (изменение материала) подсказка сообщает, как изменить свойства:

1) выбрать деталь;

2) выбрать в списке материал;

3) просмотреть или изменить свойствва во вкладке "Engineering Data" над верхней строчкой меню
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	· Мастер расчетов подсказывает, как можно выполнить действие через меню.

· В мастере расчетов доступны основные операции и расширенные возможности.

· Спрвава приведены расширенные возможности, доступные через мастер расчетов
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Цель конечно-элементного анализа - найти отклик системы на заданное внешнее воздействие.

Для решения используется математическая модель:
· геометрическая модель CAD вместе с заданным нагружением представляет собой формализованную физичскую модель;

· конечно-элементная сетка является математическим представлением геометрической модели CAD; это расчетная модель;
· точность расчетов определяется допущениями физической модели и плотностью сетки.
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	Решение задачи проходит через 4 ступени

Основные допущения

· Выбор анализа: статический, вибрационный?

· Выбор контактной модели: деталь или сборка?

· Выбор типа элементов: оболочные или твердотельные?

Препроцессинг

· Трансляция геометричской модели

· Задание свойств материалов

· Генерация сетки

· Нагружение и закрепление конструкции

· Выбор расчетных параметров.

Расчет

Постопроцесссинг

· Просмотр результатов

· Проверка достоверности решения
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2. Пример использования ANSYS Workbench для расчёта прочности поршневого пальца

Цель расчёта - оценка статической прочности поршневого пальца.

Допущения - влиянием динамических эффектов и силами трения о стенки цилиндра пренебрегаем.

Исходные данные:
· Геометрическая модель сборки поршня, поршневого пальца, вкладыша и шатуна.

· Давление на внешнюю поверхность поршня 130 атм.

2.1. Последовательность выполнения расчёта:

2.1.1. Импортирование исходной геометрии в модуль DesignModeller для редактирования.

Расчетная платформа ANSYS Workbench
Программные продукты, работающие на платформе ANSYS Workbench, относятся к новому поколению средств инженерного анализа. Отличительными особенностями модулей, работающих на этой программной платформе, являются:

· графический интерфейс, построенный на основе объектно-ориентированного принципа управления процессом работы с модулями. Под этим понимается структурное представление этапов работы в выбранном конкретном модуле в виде структурной схемы, в которой каждому этапу отвечает раздел, содержащий соответствующие объекты расчетной модели. Для каждого объекта возможен ввод и редактирование свойств;

· двунаправленная ассоциативная связь с геометрическими моделями в CAD-системах;

· общее информационное пространство управления проектом инженерного анализа. Возможность использования нескольких альтернативных способов препроцессинга и расчета для одной и той же исходной геометрической модели;

· возможность интеграции с системами управления базами данных об изделии и с системами технического документооборота (iMan, Teamcenter);

· возможность передачи КЭ-модели для дальнейшего расчета в стандартную среду ANSYS. Среда ANSYS Workbench активно развивается и уже в ближайшее время будет поддерживать не только все возможности стандартной среды ANSYS, но и возможности иных программных продуктов (в частности, LMS и CFX).

Программная платформа ANSYS Workbench позволяет в едином информационном пространстве интегрировать модули для проведения связанного многодисциплинарного анализа. Тем самым ликвидируются затраты как на передачу данных из одного приложения в другое на уровне текстовых файлов, так и на интерпретацию файлов результатов при переходе из одной системы в другую.

Используя модуль ANSYS Workbench SDK (набор инструментов разработки программного обеспечения), пользователь получает доступ к средствам создания специализированных шаблонов для типовых задач своего предприятия и может интегрировать свои расчетные приложения в рабочую среду Workbench.
Модули ANSYS Workbench.
ANSYS DesignModeler
В составе ANSYS Workbench имеется специальный модуль для 3D-моделирования, редактирования CAD-геометрии и присвоения атрибутов модели перед разбивкой.
ANSYS DesignXplorer

Поддерживая целый ряд самых современных методов оптимизации, модуль обеспечивает параметрический анализ модели, созданной ANSYS Workbench, для оценки чувствительности при планируемых модификациях. Возможен вывод откликов для прочностного и теплового расчетов как в текстовом, так и в графическом виде.
ANSYS Fatigue Module

Данный модуль позволяет оценить работоспособность конструкции при циклическом пропорциональном нагружении с постоянными либо переменными амплитудами. Возможен поэлементный вывод ресурса и долговечности, поврежденности, коэффициентов безопасности, главных и эквивалентных напряжений, а также параметров чувствительности.


Вид окна модуля DesignModeller после импортирования геометрии.

2.1.2. Упрощение геометрии. 
Поскольку конструкция и нагрузка симметричны относительно двух взаимноперпендикулярных плоскостей, то в целях уменьшения количества конечных элементов используем это свойство симметрии и рассмотрим одну четвёртую часть конструкции, а также отбросим из расчёта часть шатуна, не представляющую в данном случае интерес, отступив от места соединения его с пальцем 65 мм. На рисунке показан вид после использования инструментария модуля DesignModeller для осуществления описанных выше операций:



Подготовленная для расчёта геометрическая модель сборки.
2.1.3. Передача геометрической модели в модуль ANSYS Mechanical и задание граней модели, лежащих в плоскостях симметрии.


Условия симметрии.
2.1.4. Настройка контактных пар для учёта контактных взаимодействий в сборке. 
После импортирования геометрии в модуль ANSYS Mechanical, программа автоматически определила контактные пары, но задала их тип "по умолчанию" как склеенные (Bonded). Необходимо изменить тип контактного взаимодействия на стандартный с трением (Frictional) и задать соответствующие коэффициенты трения между деталями.



Контактные пары в сборке и построение сетки сетка конечных элементов.
2.1.5. Построение сетки конечных элементов.


Расчётная конечно-элементная сетка сборки.
2.1.6. Определение граничных условий и нагрузок. 
Ограничиваем вертикальные смещения (Displacement Y=0) для "нижней" грани шатуна и прикладываем давление на "верхнюю" поверхность поршня 13.172 МПа (130 атм.).



Нагрузки и граничные условия.
2.1.7. Настраиваем решатель и решаем задачу. 

Поскольку при нагружении детали будут деформироваться, то будет происходить изменение площадок контакта между деталями и, следовательно, будет происходить перераспределение силовых потоков, поэтому эти изменения необходимо учитывать, включив опцию учёта конечных перемещений (Large Deflection) в настройках решения (Analysis Settings). Таким образом задача становиться геометрически нелинейной и для её успешного решения следует прикладывать нагрузку постепенно, чего можно добиться "разбив" единственный шаг нагружения на последовательность "подшагов" с помощью настроек автоматического шага по времени (Auto Time Stepping). На рисунке  показано окно настроек анализа с установленными опциями.



Окно настроек анализа с установленными опциями

2.1.8. Анализ полученных результатов.



Эквивалентные напряжения Мизеса в материалах конструкции.

Поскольку цель расчёта - оценка статической прочности поршневого пальца, то необходимо получить максимальные эквивалентные напряжения в его материале.



Эквивалентные напряжения Мизеса в материале пальца.
Максимальные эквивалентные напряжения по Мизесу реализуются на внутренней поверхности отверстия в пальце, в зоне между его опорами на шатун и поршень, при этом их величина не достигает предела текучести материала пальца. Следовательно, статическая прочность шатунного пальца при однократном нагружении сохраняется.

3. Порядок выполнения работы

3.1. Решение задачи о напряженно-деформированном состоянии

Конструкционный анализ выполняется в следующей последовательности:

1. Транслировать геометрическую модель из CAD системы
2. Задать свойства материалов

3. Сгенерировать сетку

4. Закрепить модель

5. Приложить нагрузки

6. Выбрать параметры решателя

7. Задать список расчетных результатов и провести расчет

8. Просмотреть расчетные результаты
9. Сгенерировать отчет
3.1.1 Импортировать CAD модель
Геометрическую модель можно транслировать в CAE-программу двумя способами:

1) Прямая трансляция из интерфейса CAD и одновременный запуск расчетного модуля (действует для поддерживаемых CAD программ)

2) Трансляция CAD модели через интерфейс CAE программы (действует для поддерживаемых форматов файлов)
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3.1.2 Задать свойства материалов

После трансляции геометрической модели в CAE программу следует выбрать тип анализа - например, Static Structural (задачи статики) или Stress Branch (расчет напряжений), появляется мастер расчетов Stress Wizard.
В мастере расчетов следует выбрать позицию "Verify Materials" (изменить материалы), всплывающая подсказка информирует, как сделать изменение.
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В окне настроек возможен выбор материала из списка. 
По умолчанию всем детелям присваиваются свойства конструкционной стали, которые можно изменить. Выбрав в списке позицию "browse..." (поиск), пользователь получает возможность указать местоположение файла со свойствами материала в формате *.xml.
В стандартном списке присутствует несколько распространенных материалов, но пользователь может создать и использовать свою базу данных материалов.
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Для каждой детали можно назначить свой материал. Название детали транслируется из CAD модели. Одинаковые детали (например, болты) различаются присвоенными при трансляции порядковыми номерами. Одинаковые детали можно выбрать и изменить одновременно.
Чтобы получить доступ к свойствам материалов, следует нажать пиктограмму Data в меню. Появится вкладка "Engineering Data" (свойства материалов) выше верхней строки меню. Следует перейти на эту вкладку.
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3.1.3 Сгенерировать сетку.
Выбрав раздел "Mesh" (сетка) в дереве проекта, можно изменить или задать плтность сетки.

Существует несколько развитых инструментов контроля за плотностью сетки. При построении сеточной модели необходимо искать оптимальную дискретность сетки и балансировать при этом между задействованными ресурсами вычислительной системы (память, время счета и т.п.) и точностью вычислений.

Сетка с большим количеством расчетных узлов позволяет находить более точное решение, но увеличивает расчетное время и требует большого объема памяти. В идеале решение не должно зависеть от плотности сетки. Эта проблема решается через контроль за сходимостью (Convergence controls). Измельчение сетки не компенсирует ложные допущения физической модели и ошибки входных данных
3.1.4 Закрепить модель

После назначения материалов в мастере расчетов следует выбрать позицию "Insert Supports" (задать закрепление). 

В контекстных инструментах появляются пиктограммы конструкционных и тепловых нагрузок.
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3.1.5 Нагрузить модель

Нагрузки и закрепление применяются к геометрическим объектам.
Существует 2 способа приложить нагрузки

1. Сначала выбрать геометрический объект в графическом окне, затем выбрать нагрузку или закрепление в контекстных инструментах.

[image: image33.png]ot SECURED) - Adole Resder

e Edt View Document Tooks Window Hep

& @ B

AN

CAEngin

Harpy3ku 1 3aKkpenneHne NPUMEHSIOTCS K reOMeTpUYecKUM
obbekTam.

CyulecTByeT fiBa cnoco6a NpUoXuTe Harpysku.

CHayana BbIGpaTh reOMeTPUYECKUt OGBLEKT B rpachuyeckom okHe,
3arem Bhl6paTh Harpy3Kky unu sakpenieHme B KOHTeKCTHbIX
MHCTPYMeHTaX.

CHauana BbIGpaTh Harpy3Kky Uiu 3akpenseHue B KOHTEKCTHOM
MeHI0, 3aTeM BbIGpaTh reOMeTPUYECKU 0BBEKT B rpacpuyeckom
OKHe U HaXaTb “Apply” (NMPUMEHNTL) B OKHe HaCTPOeK.

2010
nigp:/cae.usturu
©0. M. Ozoposwurcea

™o e

an T
2mms





2. Сначала выбрать нагрузку или закрепление в контекстном меню, затем выбрать геометрический объект в графическом окне и нажать "Apply" (применить) в окне гнаст роек.
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После приложения нагрузок к геометрическим объектам можно ввести дополнительные данные в окне настроек. После приложения нагрузок меняетсясимвол статуса для соответствующего раздела в дереве проекта.
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Для некоторых нагрузок необходимо указывать направление.

Направление нагрузки задается в окне настроек для нагружения.

· Если выбрана позиция "Components" (компоненты) в списке, следует ввести значение нагрузки в направлениях X,Y,Z.
· Если выбрана позиция "Vector" (вектор), следует указать направление на геометрической модели и ввести значение нагрузки.

· Установки по умолчанию задаются в меню: "Tools>Options...>Simulation:Miscellaneous>Load Orientation Type
При задании направления можно ссылаться на глобальную систему координат
· Направление осей координат показано в графическом окне.

· Направление и начальная точка глобальной системы координат передается из CAD системы.

· В окне настроек для нагрузки следует выбрать позицию "Define By:Components" и ввести компоненты нагрузки в направлениях X,Y,Z.

· Можно задать и определить произвольную декартову систему координат, не связанную с исходными CAD данными.
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При задании направления можно также ссылаться на геометрическую модель. Для этого следует в окне настроек для нагрузки выбрать позицию "Define By:Vector" (задать вектор).
Можно использовать 3 типа геометрических объектов:

1. Нормаль к плоскости или ось цилиндрической поверхности

2. Прямолинейное ребро или нормаль к ребру цилиндрической поверхности

3. Две точки, определяющие направление вектора
Выберите позицию "Direction" (направление) и покажите направление вектора на геометрической модели.

Направление вектора можно сменить на противоположное, используя стрелки в графическом окне. Задав направление, нажмите кнопку "Apply" ( применить)

Введите величину нагрузки в позиции "Magnitude" (величина)
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3.1.6 Выбрать параметры решателя
После начального выбора в мастере расчетов шаблона Stress Branch (расчет напряжений) в дерево проекта помещаются некоторые расчетные параметры по умолчанию. Пользователь может зменить и добавить расчетные параметры.
В мастере расчетов следует выбрать позицию "Insert Results" (добавить расчетные параметры), всплывающая подсказка информирует о том, как добавить расчетные параметры.
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(peweHue).

PacueTHble NnapameTpsl (stress -
HanpskeHus, strain - nepemelenna,
deformation — gedpopmaums)
AOCTYNHBI B CIUCKaX KOHTEKCTHBIX
MHCTPYMEHTOB. BbiGpaHHble
pacueTHble NapameTphl NOABATCH B

pasgene “Solution” pepesa npoekTa.
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3.1.7 Провести расчет 

После назначения материалов, закрепления модели, ее нагружения и выбора расчетных параметров задача готова к вычислению!!!

Следует выбрать позицию "Solve" (решить) в мастере расчетов. После этого появляется всплывающая подсказка, которая указывает на пиктограмму, инициирующую расчет.
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Расчет выполняется в режиме пакетной обработки (batch).
При запуске решения формируется входной файл (input file) ANSYS, информацию о файле расчетных результатов можно запросить в позиции "Solution Information" раздела "Solution" (решение) дерева проекта.

Расчет можно транслировать в ANSYS
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Options... > Simulation: Solution >
Solver Working Directory”
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3.1.8. Просмотреть результаты
По окончании расчетов можно просмотреть расчетные результаты.
Расчетные результаты зависят от типа решаемой задачи.

Расчетные параметры можно вывести контурами или векторами, а также анимировать.
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3.1.9.  Сделать выводы по работе

Проанализировать полученные расчетные результаты, оценить правдоподобность проведенных расчетов, продумать и сделать рекомендации по эксплуатации конструкции.
4. Индивидуальное задание на курсовую работу

Курсовая работа на тему: «Создание параметрической 3D-модели сборочной единицы в среде КОМПАС-3D и исследование ее на напряженно-деформированное состояние в среде ANSYS» выполняется по вариантам.
Тема: «Создание параметрической 3D-модели сборочной единицы в среде КОМПАС-3D и исследование ее на напряженно-деформированное состояние в среде ANSYS Workbench» 

Цель работы: Получение практических навыков по созданию параметрических трехмерных сборочных моделей, формированию проекционных чертежей по трехмерным моделям, созданию разрезов и сечений, проведению численного анализа объектов проектирования.
Пример задания 

1. В среде КОМПАС-3D создать трехмерные модели всех деталей согласно чертежа, затем из деталей выполнить модель сборочнй единицы. 

2. На основе трехмерной модели создать ассоциативный проекционный чертеж всей сборки и одной из деталей
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ONHYECKHX OTKJIOYeHHE OfHOA wacTH TPyComposoga oOT ApY-
roft.

Knanaa cocrour H3 Kopryca nos. ! H KpHIIKH nos. 2.
Heranu mos. 5, 6, 8 ABASIOTCA 3aNOPHHM YCTPOACTBOM.
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KpHImKOH 103. 2 u ¢uiaHmeM mo3. 3 MPHMEHAIOT BOANOYHHE
Konboa mos. [5, mponHTaHHHE CMAa30YHHIMH BEIRECTBAMH.
ITo mepe u3HOCa BOANOYHBIE KOJMbIA MOMKHMAIOTCH (uiaHieM,
AJA 9ero 3aBHHUHBAIOT rafiki mo3. 10. CTHK KpPHUIKH H
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Marepuan geranefi nos. / ... 4 — CU.15 I'OCT 1412—79,
Aeranefi nos. 5 ... 9 — Crans 20 TOCT 1050—74.

OTBeTbTe HA BOMPOCH:

1. [TokaxuTe KOHTYp Herasn mo3. 2.
2. TNokaxuTe Ha 9epTexe MECTHHIAA paspe3 H CeueHHe.
3. [MokaxuTe Ha BHAe cieBa NPOKAaAKK mo3. JO u nos, 11.




Сборочный чертеж и спецификация Клапана 

3. В среде ANSYS WORKBENCH выполнить расчет напряженно-деформированного состояния детали согласно условиям варианта задания: 

Рассчитать на кручение и на изгиб Деталь №5

Закрепление -элемент Детали 5 (нижняя часть) 

Усилие приложено маховичком (Деталь № 4)

Рассчитать допустимое усилие (1% от давления разрушения)

Ход выполнения работы: 

1. Определить область применения, основные технические и геометрические параметры изделия согласно своего варианта. 

2. Создать в среде КОМПАС-3D трехмерные модели всех деталей с системами координат, необходимыми для их привязки при выполнении сборки. 

3. Затем из деталей выполнить сборочную единицу. 

4. На основе трехмерной модели создать проекционный чертеж всей сборки и одной из деталей.

На проекционном чертеже указываются размеры и линия разреза, и, затем, создается разрез сборочной единицы в 2D виде и этот разрез показывается на трехмерной модели.

5. Разработать спецификацию сборочной единицы а автоматическом режиме средствами КОМПАС.

6. Импортировать геометрическую модель одной детали (указана в задании) из среды КОМПАС-3D в среду ANSYS.

7. Используя пакет в среде ANSYS WORKBENCH выполнить расчет НДС детали согласно условиям варианта задания  

Пояснительная записка должна включать следующие разделы:

1. Титульный лист (выполненный в соответствии с ГОСТОм);

2. Индивидуальное задание (вклеить свой вариант!);

3. Содержание

4. Описание предложенного преподавателем изделия;

5. Трехмерные модели всех деталей;

6. 3D-модель выполненной сборки;

7. 2D-чертежи одной детали и сборки с простановкой размеров, техтребований и техусловий в соответствии с нормами точного машиностроительного черчения;

8. Спецификацию сборки.

9. Результаты расчета НДС детали в среде ANSYS

a) Расчетная схема (выполненная вручную) с указанием на чертеже нагрузок и закреплений.

b) Деформированное состояние (картинка)

c) Эквивалентное напряжение

d) Запас прочности и критические сечения в зависимости от условия  индивидуального задания

10. Заключение (Выводы!)

11. Список использованной литературы

Оформление курсовой работы выполняется в соответствии с требованиями ЕСКД.

Пояснительная записка должна включать следующие разделы:

12. Титульный лист (выполненный в соответствии с ГОСТОм);

13. Индивидуальное задание (вклеить свой вариант!);

14. Содержание

15. Описание предложенного преподавателем изделия;

16. Трехмерные модели всех деталей;

17. 3D-модель выполненной сборки;

18. 2D-чертежи одной детали и сборки с простановкой размеров, техтребований и техусловий в соответствии с нормами точного машиностроительного черчения;

19. Спецификацию сборки.

20. Результаты расчета НДС детали в среде ANSYS

e) Расчетная схема (выполненная вручную) с указанием на чертеже нагрузок и закреплений.

f) Деформированное состояние (картинка)

g) Эквивалентное напряжение

h) Запас прочности и критические сечения в зависимости от условия  индивидуального задания

21.  Заключение (Выводы!)

22.  Список использованной литературы

4.1 Варианты индивидуального задания

	Вариант 1



	1. Создание параметрической 3D-модели сборочной единицы в среде КОМПАС-3D в соответствии со спецификацией и 2D-сборкой
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	2. Исследование Детали на напряженно-деформированное состояние в среде ANSYS


	Рассчитать на кручение Деталь №5

Фиксация за боковую поверхность зуба шестерни (Деталь №4) 

Вращаем за шпоночный паз 

Рассчитать допустимое усилие (1% от давления разрушения)




	Вариант 2



	1. Создание параметрической 3D-модели сборочной единицы в среде КОМПАС-3D в соответствии со спецификацией и 2D-сборкой
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	2. Исследование Детали на напряженно-деформированное состояние в среде ANSYS


	Рассчитать на деформацию Деталь №2 при внутреннем давлении 10 атм

Закрепление по внутренней поверхности отверстий под болты (4 отв)

Рассчитать допустимое усилие (1% до начала пластической деформации)




	Вариант 3



	1. Создание параметрической 3D-модели сборочной единицы в среде КОМПАС-3D в соответствии со спецификацией и 2D-сборкой
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	2. Исследование Детали на напряженно-деформированное состояние в среде ANSYS


	Рассчитать на кручение и на изгиб Деталь №5

Закрепление -элемент Детали 5 (нижняя часть) 

Усилие приложено маховичком (Деталь № 4)

Рассчитать допустимое усилие (1% от давления разрушения)




	Вариант 4



	1. Создание параметрической 3D-модели сборочной единицы в среде КОМПАС-3D в соответствии со спецификацией и 2D-сборкой
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P

Kaaman cocrour ua xopayca mos. I, pamtereanoro ma

Ave HosoeT, 3 ANy w3 KoTOpIE nocTyuAer cxaTik poaty.

epeMeIENNN TONKATENN 10S. § BUpEBO ON AaBET
e e B s wanas 400 6 sasyx
UPOXOMNT t€pe3 KAAmAN MO EPONOIGMMM NasaM  HITOKS
X pacmunsoueny yerpoRcray.

Tipn CHATWN BrpySKH C TOIKSTXS KAAmAN, mTOK ¥
TOIKATEN, BOSEPAIIAOTCA B MepBOAATbHOE mONONEME
R ReAcTaNewM MPYHRN 10s. 9. B PesyaRTaTe 9TOr0 KASIAN
PWKHMACTCR X Cenxy n0S. 4, SaKpBa% NPOXOR BOSRYXA.

Saganne
Bumonmers veremn sevned 10s. | . 5.7

Marepuax xeraaed mos. 1, 6, 7 — Cr 5 FOCT 38071,
sarench mos. 38 — BpOAILTCS TOCT 613--79, serane
nos. 2, 8 — Cram, 35 454371, neramu nos. 9 —

Cram, 65T FOCT 108074,

Oraerure ua sompocs:
1. CRATbKO MpOAGAbHX nasos B Aeram nos. 37
2. Hla KaKux HsoGpAMENHAX BAANA AeTam, n0S. 42
3: epes xawoe omapemie cxaTuh soaryx. mocrymact
B Xawasx wToKa mos.





	2. Исследование Детали на напряженно-деформированное состояние в среде ANSYS


	Рассчитать на раскрытие Деталь №2

Фиксация по резьбе 

Давление на фланец  




	Вариант 5



	1. Создание параметрической 3D-модели сборочной единицы в среде КОМПАС-3D в соответствии со спецификацией и 2D-сборкой
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CawsoR xpaw woMTHpyerc Wa Xowme TpySonposoxa
W CAYKHT Aa% causa XHIKOCTH. TIDK CAMBE pYKORTKY 103, 4
YCTaNaBAWSAOT B30 TPYGONPOBOA, A4R MpEKpALERS
CAHBa — nonepex. Uro6u OGECTEUHTS EpMETHTHOCTS, KOKYC
DpoGKK 103, 2 NpHTAPaETCA K BHyTpesek crenxe Kopmyca
nos, 1.

Kpuika 103. 3 u BryaKa mos. § oSecnexHBaIOT Heo0Xo-
UMYl NAOTHOCTS NpHAETaHHS NPOKH No3. 2 K BuyTpexned
RosepxHocrk Kopnyea nos. 1.

Sananme
Bunonuts sepremu nerared nos. I ... 6.

Matepuan setaned nos.” 1, 2.4, "G - BpASMuzl
TOCT 493—79, seraed nos. 3, 4 — Cr 5 FOCT 380—71.
Oraerure a onpoca:

1. Tlokaxure ua suie cresa GopMy OTDEPCTHA KeTamK
nos. 2.

2. Hiueetca au na sepreme wsoSpaesne cevenus?
3. Mokaxure KowTyp AeTanu nos. 4.






	2. Исследование Детали на напряженно-деформированное состояние в среде ANSYS


	Рассчитать на кручение Деталь №2

Фиксация по поверхности клина и галтели 

Усилие прикладываем в месте крепления детали №4

Рассчитать допустимое усилие (1% от давления разрушения 




	Вариант 6



	1. Создание параметрической 3D-модели сборочной единицы в среде КОМПАС-3D в соответствии со спецификацией и 2D-сборкой
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	2. Исследование Детали на напряженно-деформированное состояние в среде ANSYS


	Рассчитать на кручение Деталь №2

Фиксация по поверхности клина и галтели 

Усилие прикладываем в месте крепления детали №4

Рассчитать допустимое усилие (1% от давления разрушения 




	Вариант 7



	1. Создание параметрической 3D-модели сборочной единицы в среде КОМПАС-3D в соответствии со спецификацией и 2D-сборкой


	[image: image52.png]M5

10

y/in g

1

NI

M52

)

M400.19.00.00.C6

Knanaw

Chopowweri_vepmex

B 1:2

8 Bormanton . k.

L demasuposane
15, KIATIAH CETEBOR OBPATHHR

Pr— el gl
| J—
n M4900.1900.00C5 | Coopounah seprex.
Beraan
m| | | moosoo0m | kopmye '
M| | 2| Wioiee | Kot i
M| | 3| W0is00% | Hemmem i
M| || W0 1s000s | Takma i
Al || Mc0i5000s | iy i
M| || Mucaioto0s | mapmn i
M| | 7| 000190007 | Hampansmoman i
A | 5| M00i9%00 | Myymna i
Marepuans
s Koxa 210CT 2083875 | 1
io Koa 2 FOCT 2088675 | 1

OSpaTmill ocesoll Knaman NPeXHASHAYER AMA UPEAOXP-
MeRN TA30TPOBOOR CeT C FOPIORHM FA3OM OF CAYNARHOFO
Honaxamns » Hee Bostyxa. [pH najemkn AABAeEKS KAanas

anai 3aKpenARIOT B raS0NPOBOIOR CETH P HOMOME

maxumuo rafixu uos. 4 w wrynepa mos. 5. Tpn patore

HOS. 6 , UpeORONenas ycuAue HpYMuEH 105, §, OTAMAET
ero or xomwueckoro orsepcrun xopmyca nos. 1.'B o6paso-
Basueccs OTBepCTHe ras IPOXOMAT B TASOMOBOLEYIO CeTS.

wryep.
B cayuae sspupa rasouiciopomsol cueen » cen raso-
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	2. Исследование Детали на напряженно-деформированное состояние в среде ANSYS


	Рассчитать на внутреннее давление  Деталь №1

Фиксация по наружной резьбе и по торцу 

Усилие прикладываем в месте крепления детали 

Рассчитать допустимое усилие (1% от давления разрушения)




	Вариант 8



	1. Создание параметрической 3D-модели сборочной единицы в среде КОМПАС-3D в соответствии со спецификацией и 2D-сборкой
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Tloxasa Tommmsa 5 Gopeysxy NPOHCXONT Sepes HAITENS

o Koraa ol BogAy m Kownpecsops. Tio xanany
Cotlia D03, 2 llap YCTpEMARETCR X BHEORY, TI€ OF HOXDE.
Tuaer KOS TOUAKBO K pacmuaser ero. Koawtecrso
HOASBAEMOrO B TOKY KOTAQ TONAHBA MONHO Hauem
BpamENHei MAXOBHKa 113. 8, PETYANPYA TeM Cauik B
HRY 5830pa MEXRY KONHWECKHMH OBEPXHOCTAMH CONAa
503, 2 K xopayca mos. 1.

Sazamee
Bumonmurs seprey seranch mos. 1 ... Tocrpours
axconoueTpRCCKY® TpOCKIO AeTaTR 103,
wan  ereaed mos. 1.7 — BpOSUSCS
TOCT 61379, aeraan mos. 8 — Cr 3 FOCT 88071,

Omserste ma sonpocs:
1. Hasosure neraau » cesesnu 5—

2. Bumnu 4 perans nos. 2 % 5 ma paspese A—A m
‘sz caepxy?
3. Cromb

© cevemuh HMeecs Ha amuOM Seprexe?

%0

MY 00.08.00.00.C5

[forcgm

dopcynna

Coopounsii vepmen:

(Mpurs






	2. Исследование Детали на напряженно-деформированное состояние в среде ANSYS


	Рассчитать на раскрытие   Деталь №7

Фиксация по резьбе 

Усилие прикладываем вверх по оси на боковую поверхность 

Рассчитать допустимое усилие (1% от давления разрушения)




	Вариант 9



	1. Создание параметрической 3D-модели сборочной единицы в среде КОМПАС-3D в соответствии со спецификацией и 2D-сборкой
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Ilheswatiteckuh nopuIHEDoR NpHBOR SBASETCR_ Henod-
TEMbHM MEXAHWIMON OBAOCTOPOHiErO. ACRCTBHR ' TpeX-
Hadauen A ynpaniewAs 3actomkoR rasomol orcevkh
Harpesatebinx Konomnes,

Tpn oxnosennn npwvoza cxaTssh s0sayx, mocrynaromrh
S€pes OThepCrHe. KPHIKH 103, 4, NEpEMEIACT BIPARO Mop-
ek 103, 5, 4 oK noa. 7 ¢ BiAKoR T0s. 3 AeAcTRyer na
MpHBOHOR Gpra, ¢ KoTopiM o coexiew. [1pH npexpame-
HiH NOXATH CATOTO BOSRYXA B UAARAZP Na, | UpywWHEA
103, § BoabpalaeT NopIENs NPHBOAA B AEXooE HOONE:
He. B UMARNADE WMECTCA OTBEPCTHE, COCIAHAOE TPABYIO
€0 nosocrs ¢ anocdepod.

Saxanne
Bunonnus sepren aeraed nos. 1 .. 7.
Matephan seraned nos. I ... 4 — CH. i FOCT 41279,

aeraneh moa. 5, 7 — Crans 20 TOCT 105074, peramn
nos. 6 — Crans 65I' TOCT 1050—74.

Omersre na nonpocu:
1. Ha xaxnx wsoSpamensax swasa gerans mos. 22
2. CronuKo orocperu noA mme bk et Rerah D0S. 17
3 Hasonime sce Aeraaw, wioSpumeniue Ha. paspese
5.





	2. Исследование Детали на напряженно-деформированное состояние в среде ANSYS


	Рассчитать на изгиб   Деталь №7

Фиксация Деталь №5 

Усилие прикладываем на Деталь №5 - 4 атм 




	Вариант 10



	1. Создание параметрической 3D-модели сборочной единицы в среде КОМПАС-3D в соответствии со спецификацией и 2D-сборкой
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5.9, 11— Cram 20

Cram 65T

Aeraneh
CU 15 FOCT 141279, zeraneh nos.
1050—74,  xeraxn
FOCT 1050—74.

Orserare ma nompocu:
1. Toxamare xomTyp Aerann_noo.

2. Ha xaxnx wsoSpaxennsx swina Acrat nos. 2
3 Gaotnso oraeperuh mok Goa ueeten 8 Reraan

E

1 N4
%

%)

==

=

ponuKobsid

Coapownuis vepmen

12






	2. Исследование Детали на напряженно-деформированное состояние в среде ANSYS


	Рассчитать на срез деталь №8

Закрепление детали 9,10

Усилие   300кг приложено на деталь №6
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